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第一章 ICETEK-DM642-B 评估板简介 

 

这一章主要给出了 ICETEK-DM642-B 评估板的简要概述、主要特点和电路板的图示。 

1.1 主要特点 

ICETEK-DM642-B 评估板是一个低功耗独立的开发平台，使用户可以对 TI 的 C64xx DSP

系列进行评测和开发应用。ICETEK-DM642-B 评估板还可以作为为 TMS320DM642 DSP 芯片设

计的硬件参考板。 

 

图 1-1  ICETEK-DM642-B 评估板实物图 

ICETEK-DM642-B 评估板适合各种应用环境。ICETEK-DM642-B 评估板的主要特点包括： 

 一颗 TI 公司 600MHz 的 TMS320DM642 DSP 芯片 

 一颗 PHILIPS 公司的 LPC2214 ARM 芯片 

 1 路视频输入端口——PAL 制式 

 1 路视频输出端口——PAL 制式 

 4M*64bit 同步动态存储器（SDRAM），存储多达 32 帧图像  

 8~32M 位 Flash：可以写进大量程序，具备自启动功能，可作为嵌入式的产品使用 



        REALTIME—DSP系列应用丛书 

 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                      http://www.realtimedsp.com.cn 
电话：010-62105690（中继）/ 91-94                                      传真：010-62105699     

2

 AIC23 立体声数字信号编解码器 

 10~100M 以太网端口 

 板上 JTAG 仿真接口 

 单+5V 电压供电 

 一路 RS232 串口驱动 

1.2 ICETEK-DM642-B 评估板功能概述 

ICETEK-DM642-B 评估板上的 DSP 芯片通过 64bit 的 EMIF 接口或 8/16bit 的 3 路视频接口

连接板上外围设备。SDRAM 和 Flash 每一个设备占用其中的一个接口。 

评估板上的视频解码器和编码器连接到视频端口上。评估板上的 1 个解码器和 1 个编码器

符合标准规范。 

评估板上的 AIC23 多媒体编解码器允许 DSP 进行模拟音频信号的输出和接收。I2C 总线用

来控制编解码器端口，McASP 被用来控制数据。模拟信号通过 3 个音频接口进行输入输出，其

相应的分别是麦克风输入（microphone input）、直接输入（line input）和直接输出（line output）。

编解码器可以选择麦克风输入或直接输入作为主动输入，模拟输出被指定为直接输出接口。

McASP 可以通过软件重新设定成为一个扩展接口。 

评估板上设计有+5V 电源作为独立的器件为板卡供电。板上的配电系统为 DSP 内核提供

+1.4V 的电压，为 I/O 提供+3.3V 的电压。在板卡电源供给正常之前，板卡保持复位状态。板卡

上还设计有电源芯片，用来为 ARM 内核和编码器提供+1.8V 电压。 

仿真器与评估板通过 14 针的扩展 JTAG 端口进行连接通信。 

1.3 基础操作 

ICETEK-DM642-B 评估板由 TI 公司的 CCS 软件工具进行开发。Code Composer 与

ICETEK-DM642-B 评估板通过 JTAG 扩展仿真接口进行连接通信。安装 CCS 软件的过程将安装

所有的开发工具、文档和驱动程序。 

1.4 存储器映射 

C64xx 系列 DSP 有大量的字节可设定的地址空间。程序代码和数据可被存储在统一标准的

32bit 地址空间的任何位置。 
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下图的内存映射，左边显示了普通的 DM642 处理器的地址空间，右边显示了

ICETEK-DM642-B 评估板的地址空间。默认状态下，内部的寄存器从 0x00000000 地址空间开

始存储。一部分存储器可由软件重新映射为 L2 高速缓存，而不是固定的 RAM。 

EMIF（外部存储器端口）有 4 个独立的可设定地址的区域，称为芯片使能空间（CE0-CE3）。

Flash 映射到 CE1 空间，SDRAM 占据 CE0 空间。 

地址 普通的 DM642 处理器 ICETEK-DM642-B 评估板 

0x00000000 Internal Memory/Cache Internal Memory/Cache 

0x00040000 
Reserved Space  or 

Peripheral Registers 

Reserved Space  or 

Peripheral Registers 

0x80000000 EMIF CE0 SDRAM 

0x90000000 EMIF CE1 Flash 

0xA0000000 EMIF CE2 CE2 

0xB0000000 EMIF CE3 CE3 

图 1-2  DM642 评估板寄存器映射 

 

1.5 电源 

ICETEK-DM642-B 评估板的运作是通过主电源（J2）输入+5V 电源。在内部，+5V 输入电

源被整流分为+1.4V 和+3.3V。+1.4V 的电压被提供给 DSP 处理器，+3.3V 的电压提供给 DSP

内的 I/O 和评估板上其他芯片。电源的端口是 2.1m 的桶式插孔。单独的电源芯片用来为 ARM

芯片和视频输入提供电压。 
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第二章 ICETEK-DM642-B 评估板板卡构成 

 

这一章主要描述了 ICETEK-DM642-B 评估板的板上主要组成部件情况。 

2.1  EMIF 端口 

ICETEK-DM642-B 评估板合并形成了一个 64bit 长的外部存储器端口。将地址空间分割成

了四个芯片使能区，允许对地址空间进行 8bit、16bit、32bit 和 64bit 的同步或不同步的存取。

ICETEK-DM642-B 评估板使用芯片使能区 CE0 和 CE1。CE0 被分配给 64bit 的 SDRAM 总线。

CE1 被 8bit 的 Flash 使用。 

 

表 2-1  EMIF 端口 

芯片选择 功能 

CE0 SDRAM 总线 

CE1 8bit Flash  

CE2 保留未使用 

CE3 保留未使用 

 

2.1.1  SDRAM 寄存器端口 

ICETEK-DM642-B评估板在CE0空间连接了 64bit的SDRAM总线。这 32M字节的SDRAM

空间用来存储程序、数据和视频信息。总线运行在 100MHz 或以上的最佳运行状态。SDRAM

的刷新由 DM642 芯片自动控制。 

DM642 芯片可以配置 EMIF 时钟的原始值。ICETEK-DM642-B 评估板的 ECLKIN 针脚一

般为默认值，但其也可通过分频 CPU 时钟，来控制 EMIF 的时钟频率。在复位时，通过对

ECLKINSEL0 和 ECLKINSEL1 针脚的操作进行设置，其与 EA19 和 EA20 针脚共同分享 EMIF

的地址空间。下表列出了配置模式。 
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表 2-2  EMIF 端口 

ECLKINSEL0 ECLKINSEL1 模式 

0 0 ECLKIN* 

0 1 CPUCLK/4 

1 0 CPUCLK/6 

1 1 ECLKIN 

注：“*”为缺省设置 

 

2.1.2  Flash 寄存器接口 

ICETEK-DM642-B 评估板有 8~32M 位的 Flash，映射在 CE1 空间。Flash 寄存器主要被用

来导入装载和存储用户程序。ICETEK-DM642-B 评估板的 CE1 空间被配置成 8bit，Flash 寄存

器也是 8bit。 

 

2.2  视频端口/McASP端口 

ICETEK-DM642-B评估板有3个板上视频端口，这些端口根据可选择性功能，进行再分类。

例如端口0和端口1的McASP和SPDIF功能。ICETEK-DM642-B评估板使用所有的三个视频端口中的

视频端口0和视频端口2，视频端口0被用作输入端口，视频端口2用作显示端口，视频端口1扩展

在板上供用户使用。 

2.2.1  视频解码器端口 

在ICETEK-DM642-B评估板中，可再分的视频端口0被用作捕获输入端口，命名为捕获端口1。

这些端口连接到TVP5150解码器。捕获端口1输入的必须是合成的视频源，例如DVD Player或视频

相机。TVP5150是可通过DM642的I
2
C总线进行编程的。 

2.2.2  视频编码器端口 

ICETEK-DM642-B评估板的视频端口2被用来驱动视频编码器。视频端口2是直接通过视频，

连接到SAA7121视频编码器。SAA7121的内部编程寄存器通过DM642的I
2
C总线进行配置。 

2.2.3  AIC23端口 

评估板使用TI的AIC23立体声数字多媒体编解码处理器进行音频信号的输入输出。编解码器
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通过麦克风采样模拟音频信号或直接输入模拟音频信号，然后将其转换为DSP可以处理的数字数

据。当DSP处理完数据后，再将数据转换为模拟信号输出，用户即可在输出处听到音频信号。 

编解码器通过2路连续的通道进行通讯，一路控制编解码器的端口配置寄存器，另一路发送

和收取数字音频采样。I
2
C总线被用来作为单向控制通道。控制通道只在配置编解码器时才使用，

当传输音频信号时，一般它是空闲的。 

McASP被用来作为双向数据通道。所有的音频数据都通过数据通道传输。许多数据格式是由

采样宽度、信号时钟源和连续数据格式三个易变的量决定的。首选的连续信号模式是匹配McASP

脉冲模式的DSP模式。 

下图显示了ICETEK-DM642-B评估板的编解码器端口。 

 

图 2-1  ICETEK-DM642-B 评估板多媒体信号编解码器端口 

2.3  Ethernet 端口 

ICETEK-DM642-B 评估板提供以太网 MAC 端口。 

在独立的模式下，ICETEK-DM642-B 评估板的以太网 MAC 被自动选择，并通过 CBT 发送

给 PHY。ICETEK-DM642-B 评估板使用的是 Intel LXT971 PHY。10/100Mbit 的端口输出至评估

板上单排插针，J3。PHY 直接连接到 DM642。 

2.4  I2C 端口 

DM642 中利用 I2C 总线连接驱动设备的控制寄存器是理想的。在 ICETEK-DM642-B 评估

板中 I2C 总线用来配置视频解码器、视频编码器和立体声数字编解码器。I2C ROM 通过连续的

总线接口，下图显示了总线的格式。 
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图 2-2  I2C 总线格式 

下表显示了板上外围设备的地址。 

表 2-3  I2C 寄存器映射 

驱动 地址 写/读 功能 

TVP5150 0x42 R/W 捕获通道1解码器 

SAA7121 0x88 R/W 编码器 

TLV320AIC23 0x1A R/W CODEC 

2.5  DM642 核心 CPU 时钟 

ICETEK-DM642-B 评估板使用一个 50MHz 的振荡器产生输入时钟 CLKIN。DM642 有一个

内部 PLL，用来倍频输入时钟，产生内部时钟。PLL 乘法器通过 DM642 上的 CLKMODE0 和

CLKMODE1 针脚设置。复位后，这些针脚被采样，确定 PLL 乘法器的模式，确定内部 CPU 时

钟。 

下表显示了 PLL 乘法器的特殊用途。 

表 2-4  DM642 CPU 核心时钟 

CLKMODE1 CLKMODE0 PLL Multiplier 频率 

0 0 Bypass 50 Mhz 

0 1 CLKIN times 6 300 Mhz 

1 0 CLKIN times 12* 600 Mhz 

1 1  Reserved 

          注：“*”为缺省设置 
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第三章  实物描述 

这一章主要描述了 ICETEK-DM642-B 评估板的实物布局和它的连接器。 

3.1 评估板版面布局 

ICETEK-DM642-B 评估板为 95×125mm 的多层板，由一个外扩的+5V 电源供电。图 3-1

显示了 ICETEK-DM642-B 评估板的布局示意图。 

 

 
图 3-1  ICETEK-DM642-B 评估板布局示意图 

3.2 连接器 

ICETEK-DM642-B 评估板为了方便用户在板卡上存取各种信号，共提供了 6 个连接器。 

表 3-1  ICETEK-DM642-B 评估板连接器 

连接器 针脚 功能 

J2 2 单+5V输入连接器  

J4 26 音频、视频输入和VP1接口 

J5 26 RS232和用户接口 

J3 4 Ethernet接口 

J6 2 视频输出接口 

J1 14 JTAG接口 

J6 J2 J1

J4 

J3 

J5 
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3.2.1  J2，单+5V 输入连接器 

ICETEK-DM642-B 评估板可以独立的供电。输入仅提供+5V 的电压。 

独立供电模式下，5V 电源连接到 ICETEK-DM642-B 评估板的 J2 连接器上。连接器的外径

为 5.5mm，内径为 2.1mm。下图显示了 J2 连接器的外观。 

 

 

图 3-2  J2，+5 V 输入连接器 

 

3.2.2  J4，音频、视频输入和 VP1 接口 

J4 连接器提供音频、视频输入和 VP1 接口。下表列出了通过各针脚的信号。 

表 3-2  音频、视频输入和 VP1 接口 

针脚 信号名称 

1 左声道麦克风输出 

2 右声道麦克风输出 

3 音频地 

4 音频地 

5 左声道线性输出 

6 右声道线性输出 

7 音频地 

8 音频地 

9 左声道线性输入 

10 右声道线性输入 

11 VP1D9 

12 VP1D8 
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13 数字地 

14 VP1D7 

15 VP1D6 

16 VP1D5 

17 VP1D4 

18 数字地 

19 VP1D3 

20 VP1CLK0 

21 VP1CTL1 

22 VP1D2 

23 VP1CTL0 

24 数字地 

25 视频输入 

26 视频地 

 

 

3.2.3  J5，RS232 和用户接口 

J5 连接器是一个集成了 RS232 和用户接口的双排插针，J5。下表列出了通过各针脚的信号。 

表 3-3  J5, RS232 和用户接口 

针脚 信号名称 

1 232输出 

2 232输入 

3 数字地 

4 系统复位 

5 TDI LPC 

6 TDO LPC 

7 数字地 

8 TCK LPC 

9 TMS LPC 

10 TRST LPC 

11 数字地 

12 LPC RTCK 

13 LPC TXD1 

14 LPC RXD1 
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15 数字地 

16 用户I/O0 

17 用户I/O1 

18 用户I/O2 

19 用户I/O3 

20 用户I/O4 

21 用户I/O5 

22 用户I/O6 

23 用户I/O7 

24 数字地 

25 数字地 

26 +5V电源 

3.2.4  J3，以太网连接器 

连接器 J3 是一个 4 针的单排插针。下表列出了通过各针脚的信号。 

表 3-4  J3 连接器输出 

针脚 信号名称 

1 LAN_TX+ 

2 LAN_TX- 

3 LAN_RX+ 

4 LAN_RX- 

 

 

3.2.5  J6，视频输出接口  

连接器 J6 是一个两针的视频输出接口。下表列出了通过各针脚的信号。 

表 3-5  J6 视频输出接口定义 

针脚 信号名称 

1 视频输出 

2 视频地 

 

3.2.6  J1，JTAG 端口 

ICETEK-DM642-B 评估板提供了 14 针的插针接口，J1。JTAG 仿真器通过这个标准的接口
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对 TI 的 DSP 进行仿真。下图显示了连接器的各针脚输出。 

 

图 3-3  JTAG 端口 

3.3 系统状态指示灯 

ICETEK-DM642-B 评估板提供 5 个指示灯（DS1-DS5）。这些灯的颜色和功能显示在下表

中。 

表 3-6  ICETEK-DM642-B 评估板指示灯 

编号 颜色 功能 

DS1 黄 复位指示灯，评估板复位时点亮 

DS2 黄 电源指示灯，评估板上电正常时点亮 

DS3 红 网络指示灯，网络连接时点亮 

DS4 红 网络指示灯，网络连接时点亮 

DS5 红 网络指示灯，网络连接时点亮 

3.4  复位开关 S1 

ICETEK-DM642-B 评估板可以通过两种方法进行复位。第一种是电源复位。通过对

ICETEK-DM642-B 评估板的通断电进行复位。 

第二种是按下复位开关 S1。当这个开关被按下时，评估板处于复位状态。 
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第四章  ICETEK-DM642-B 板 ARM 模块使用说明 
ICETEK-DM642-B 板上具有一个辅助处理器，型号为 LPC2214，是 PHILIPS 公司采用

ARM7TDMI 内核制造的单片机。 
在 ICETEK-DM642-B 板上，ARM 处理器主要负责实现串口通讯和 I/O 输入输出功能，由

于 ARM 处理器本身软件编程开发与主处理器 DM642 独立，因此，在这个说明中，我们把这部

分电路及功能简单称为 ARM 模块。 
本文的内容只是说明 ARM 模块的工能和使用方法，所以，在这里没有对 ARM 编程的具

体细节作详细和完整地的介绍，关于 ARM 的相关内容，请自行参考 ARM 公司和相关芯片的

文档。 
本文内容如下： 
1、 ARM 模块的硬件电路和功能 
2、 ARM 模块预编程序的使用说明 
3、 ARM 模块的烧写 

 
4.1  ARM 模块的硬件电路和功能 

ARM 模块的结构示意图如下： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ARM 
LPC2214 

E
M
C

             

DM642 
 
 
H 
P 
I 

 
18.432MHz 

JP1 

 
J5： 
JTAG 
Power 

Ground 
I/O 
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ARM 模块的主芯片采用 PHILIPS 的 LPC2214FBD144，其工作主频最高可以达到

60MHz，具有片内 PLL，可实现自定义的倍频/分频能力。在 ICETEK-DM642-B 板上，ARM
模块的输入频率为 18.432MHz，利用这个频率，可以最好的匹配计算机异步串口所使用的

传输波特率。 
ARM 模块使用的处理器是采用 3.3V 电压供电的，不适合连接需要 5V 信号才能工作

的外部器件，如果需要在 J5 上连接外部扩展硬件，请注意电器特性的匹配。 
ARM 模块的一个最主要的功能就是与本板的主芯片 DM642 进行通讯，通讯的目的就

是把 J5 上的信号送到 DM642 上，或者利用 J5 的信号把 DM642 的信息传送出去。 
ARM 模块与 DM642 之间的讯联系使用 LPC2214 芯片的外部扩展总线和 DM642 的

HPI 接口来实现。LPC2214 的外部扩展总线是标准的 AHB 外扩总线，具有多条独立的数

据线和地址线，总线输出片选信号和读/写信号，用于访问标准的类似 SRAM 的外部设备。 
DM642 的 HPI 接口只有很少的几根地址线，数据和地址使用同一个 16 位的通道来传

输，地址信号作为输入送到 HPI 接口内部的寄存器中，而数据则在 LPC2214 的片内 RAM
和 DM642 的片内/外存储器之间传输。除了 HINT 信号和数据线之外，所有的 HPI 接口信

号都是 DM642 的输入信号，这也就意味着，DM642 不能通过 HPI 主动输出任何数据，从

LPC2214 看来，通过 HPI 访问 DM642，就如同访问自己的片外存储器一样。所有的数据

读写操作都可以主动的发起而不受任何约束。 
利用 HPI 总线，还可以实现 LPC2214 和 DM642 的中断方式通讯，利用 HPI 的内部寄

存器，LPC2214 可以通过写寄存器的状态位来触发 DM642 的 HPI 中断，同时，HPI 接口

的 HINT 管脚可以输出低电平，为 LPC2214 提供可查询的输入口或者中断（LPC2214 和

HINT 连接的管脚既可以做 I/O 口，也可以作为中断信号）。 
HPI 的另一个主要功能是如何使用扩展在 J5 上的信号线。首先，通过下面的列表给出

J5 上的扩展引脚： 
管脚名 管脚序号 管脚名 

232OUT 1 2 232IN 

GND 3 4 SYSTEM_RESET

TDI 5 6 TDO 

GND 7 8 TCK 

TMS 9 10 TRST 

GND 11 12 RTCK 

TXD1 13 14 RXD1 

GND 15 16 USER_IO0 

USER_IO1 17 18 USER_IO2 

USER_IO3 19 20 USER_IO4 

USER_IO5 21 22 USER_IO6 

USER_IO7 23 24 GND 

GND 25 26 +5V 
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J5S 上的引脚可以分成四组： 
第一组：由 3、7、11、15、24 和 25 组成，共有 6 根，它们是 B 板的地线。 
第二组只有 26 脚 1 根，它是 B 板供电电源（+5V）的直接输出，注意，如果需要扩展

的外部硬件使用这个管脚供电的话，请注意为整个 B 板供电的电源功率要足够大。 
第三组：由 4、5、6、8、9、10 和 12 脚组成，它们的管脚和信号名对应关系参考上表。

这组信号是 LPC2214 的 JTAG 管脚（JTAG 的管脚还包括 26 脚电源和任意一个地线）。

如果想对 ARM 模块进行调试和开发，可以使用这组管脚。为了这个目的，其中 RTCK
在 B 板上已经连接了 4.7K 的下拉电阻。 
此外，第 4 脚 SYSTEM_RESET 还作为 B 板的全局复位引脚，从这个引脚输入的低电

平将会复位 ARM 模块，DM642 和其他的板上外设。 
一般来说，ARM 的 JTAG 接口标准如下： 

电源 1 2 电源 

nTRST 3 4

TDI 5 6

TMS 7 8

TCK 9 10

RTCK 11 12

TDO 13 14

nRST 15 16

NC 17 18

NC 19 20

 
 
 
 
地线 

因此，在调试之前，需要把 J5 上的信号与 ARM 的 JTAG 接口连接在一起，连接图如

下： 
B 板 J5  JTAG 接口 
RESET 4 ———————————— 15 nRST 

TDI 5 ———————————— 5 TDI 
TDO 6 ———————————— 13 TDO 
GND 7 ———————————— 4 地线 
TCK 8 ———————————— 9 TCK 
TMS 9 ———————————— 7 TMS 

TRST 10 ———————————— 3 nTRST 
RTCK 12 ———————————— 11 RTCK 

+5V 26 ———————————— 1 电源 
第四组：由 1、2、13、14、16、17、18、19、20、21、22 和 23 共 12 根信号线组成。

其中 1 和 2 两根管脚不由 LPC2214 直接引出，而是经过 MAX2232E 驱动之后引出，

可以直接与计算机连接。 
其他信号为 LPC2214 直接引出。B 板把 1 和 2 作为异步串口，13 和 14 作为无驱动的
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另一个备用串口看待，而 16 到 23 脚作为通用输入输出管脚。实际上，13、14 和 16
到 23 这些管脚均可复用为其他管脚，下面是这些管脚的功能列表： 

J5 序号 LPC2214 管脚号 LPC2214 管脚名称 

13 75 P0.8/TxD1/PWM4 

14 76 P0.9/RxD1/PWM6/EINT3 

16 4 P0.21/PWM5/CAP1.3 

17 5 P0.22/CAP0.0/MAT0.0 

18 6 P0.23 

19 123 P0.20/MAT1.3/SSEL 

20 122 P0.19/MAT1.2/MOSI/CAP1.2 

21 121 P0.18/CAP1.3/MISO/MAT1.3 

22 101 P0.17/CAP1.2/SCK/MAT1.2 

23 100 P0.16/EINT0/MAT0.2/CAP0.2 
其中，主要的是：J5 的 14 脚和 23 脚可以用来作为中断输入，而 J5 的 19 到 22 可以

用作主模式或从模式的 SPI 串行接口。 
 
最后，是 JP1 开关（在 B 板的背面），它控制着 ARM 模块的工作方式，现在，只有 JP1

的第 1 个开关有效，当这个开关为 OFF 时，ARM 处于用户模式，将会运行烧写在芯片内

的程序，当这个开关为 ON 状态时，ARM 模块处于烧写片内 Flash 的状态。(ISP 模式) 
 

4.2  ARM 模块预编程序的使用说明 
B 板在生产时会在 ARM 中烧入一个已经编好的程序，同时提供一个 Dm642 程序来测

试，本节就介绍这个通讯程序的使用。 
1、 程序文件： 

ARM 模块的程序都在 rev1 目录中，其中： 
ARM 子目录包含了烧写到 Flash 中的程序 
DSP 子目录包含了 DSP 上运行的工程文件 
LPC210x_ISP.exe 是烧写 ARM 的工具 
串口调试助手 V2.0B.exe 是串口调试的辅助工具 
ARM 目录下的 src 目录是 ARM 程序的源代码 
ARM 目录下的 Rev1_flash.hex\ ROM_EXEC.hex 文件是烧写程序的二进制码 
ARM目录下的Rev1_flash.mcp文件是ADS编译程序用到的工程项目文件，用ADS
打开这个文件就可以编译修改 ARM 源代码了。 

2、 执行测试程序 
1. 运行“串口调试助手 V2.0B.exe”，得到如下界面： 
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2. 修改串口波特率为 115200，如下图： 
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3. 运行 CCS，加载 rev1.out 文件，运行 
4. 此时，在串口调试助手上显示出“1234567”7 个字符，这些字符是 DSP 发

送给计算机的：结果如图： 

 

5. 修改串口调试助手下方的发送区，使之保留 8 个发送的任意字符，并且以“.”
结尾，如图： 
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6. 点击 “手动发送”，可以看到发送的字符被倒序传回计算机。如图： 
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7. 停止 CCS，退出，结束程序执行 
4.3  ARM 模块的烧写 

ARM 模块的编程最常见的是使用 ADS1.2 开发环境，不需要特殊的软件。而调试则需要有

JTAG 仿真器的参与，烧写只需要带串口的计算机和 PHILPS 提供的 ISP 软件就可以了。下

面介绍 ARM 模块的烧写。 

● 烧写程序流程 
1、 把计算机的串口的 2 和 3 与 J5 的 1 和 2 连接，串口的地线 5 与 J5 的地线 GND 连

接（J5 的 3、7、11、15、24 或 25 任意一根）。 
2、 把 JP1 的 1 拨到 ON 状态 
3、 给 B 板上电。 
4、 运行 rev1 目录下的 LPC210x_ISP.exe 程序，看到烧写程序界面如下： 
 
 
 
 
 
 
 

 
 
 
 
 
 

5、 在界面的“Device”下选择器件和时钟频率，如下图： 
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6、 点击界面中的“Read Device ID”按钮，出现提示对话框如下： 

 
点击对话框中的“确定”按钮，等到程序执行完成。 
如果程序正确的完成了操作：会在状态栏提示：“Read Part ID Successfully”，如

下图 

 

此时，进入 7 步骤 
如果程序没有正确完成操作：会出现对话框提示：如下图 

 

此时，单击“确定”，按一下 B 板上的 S1，复位系统，然后重新点击“Read Device 
ID”按钮。 
7、 点 击 “ filename ” 右 下 方 的 “ 。 。 。 ” ， 选 择 文 件

“<roodir>\rev1\arm\Rev1_flash.hex\ROM_EXEC.HEX” 
8、 点击“Upload to Flash”按钮，等待程序结束，此时，程序已经烧到片内的 Flash

中。 
    最后，为了保证程序的运行，请将 B 板断电，把 JP1 的 1 脚拨到 OFF 状态。 
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第五章  ICETEK-DM642-B 

实验系统的安装说明 
 
 
5.1 软件安装 

 

注： 以下软件安装过程仅限使用 ICETEK-5100USB 型开发系统，如使用其他型号开发系统，

请参考开发系统的使用说明书。 

 

1．安装 CCS2.20：将附带光盘“CCS 开发软件”目录中的“ccs6000.exe”解压缩到硬盘并

执行其中的“setup.exe”，然后按照提示安装软件，最好安装在默认目录(c:\ti)中。本文档默认

用户程序安装在 C：\ti 目录下，如用户更改安装目录，请相应更改文档的中涉及的路径名称。 
2 ． 升 级 CCS 到 CCS2.21 ：。 将 附 带 光 盘 “ CCS 开 发 软 件 ” 目 录 中 的

“ C6000-2.20.00-FULL-to-C6000-2.21.00.01-FULL.exe ” 解 压 缩 到 硬 盘 并 执 行 其 中 的

“setup.exe”，然后按照提示安装软件。 
3．安装仿真器驱动程序：按照仿真器安装说明安装。 
4．安装 DM642 编程环境：运行光盘“TMS320DM642 EVM”目录中的“SetupEVMDM642.exe”，
然后按照提示安装软件，安装在默认目录(c:\ti)中。 
5．安装 DDK：运行光盘“TMS320DM642 EVM\AddOns\DDK”目录中“ddk_v1_10_00_23.exe”，
然后按照提示安装软件，安装在默认目录(c:\ti)中。 
6．安装 NDK：运行光盘“TMS320DM642 EVM\AddOns\NDK”目录中的“NdkStart.exe”，
然后按照提示安装软件，安装在默认目录(c:\ti\C6000\NDK)中。 
7 ． 安 装 RF ： 运 行 光 盘 “ TMS320DM642 EVM\AddOns\RF ” 目 录 中 的

“referenceframeworks210.exe”，然后按照提示安装软件，安装在默认目录(c:\ti)中。 
8．安装 FlashBurn：运行光盘“TMS320DM642 EVM\AddOns\FlashBurn”目录中的

“C5000C6000-2.20-SA-to-TI-FLASHBURNa.exe”，然后按照提示安装软件，安装在默认目录

(c:\ti)中。 
9．安装实验程序：将光盘“软件测试程序”目录中的“ICETEK-DM642-EDULab”子目录复

制到 C 盘根目录。使用“我的电脑”将目录“C:\ICETEK-DM642-EDULab”及其包含的子目

录、文件的只读属性去掉。 
10 ． 安 装 初 始 化 仿 真 器 程 序 ： 将 “ c:\ICETEK-DM642-EDULab ” 子 目 录 下 的

“ICETEKEMUReset.bat”复制到“c:\ti\cc\bin”目录。将“c:\ICETEK-DM642-EDULab”子

目 录 下 的 “ icetek.cfg ” 复 制 到 “ c:\ti\cc\bin\BrdDat ” 目 录 。 用 鼠 标 右 键 单 击

“c:\ICETEK-DM642-EDULab”子目录下的“初始化 ICETEK-5100 USB2.0 仿真器”文件名，

选择“发送到”->“桌面快捷方式”。 
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5.2 设置 CCS 

1．启动Setup CCS 2，选择Clear；在选择驱动ICETEK USB Emulator for ’C64xx；点击Import
加入驱动；再点击Close，关闭窗口； 

2．鼠标右键单击System Configuration 窗口中的C64xx XDS510 Emulator，选择Properties…； 

单击Startup GEL File(s)属性页；单击“..”键；选择c:\ti\boards\evmdm642\gel 目录中的文件；

Finish； 

3．选择File，Exit。 

 

5.3 实验操作 
 

1．如果进入 CCS 提示错误，先选“Abort”，然后用“初始化 ICETEK-5100 USB2.0 仿真器”

初始化仿真器，如提示出错，可多做几次。如仍然出错，拔掉仿真器上 USB 接头(白色方形)，
按一下 ICETEK-DM642-B 板上 S3 复位按钮，连接 USB 接头，再做“初始化 ICETEK-5100 
USB2.0 仿真器”。 
2．如果遇到反复不能连接或复位仿真器、进入CCS报错，请打开Windows的“任务管理器”，

在“进程”卡片上的“映像名称”栏中查找是否有“cc_app.exe”，将它结束再试。 

3．在切换测试程序或需要重新运行程序时，首先停止程序运行，然后选择GEL菜单中的

“Resets->Reset_BreakPts_and_EMIF”进行复位，再加载程序运行。 

4．实验中如需要复位ICETEK-DM642-B板时请首先退出CCS。如果遇到CCS停止反应情况，可以

用鼠标右键单击任务条上“Code Composer”并选择“关闭”，或拔出仿真器上的USB接头。 

 

5.4  实验操作注意事项 
 

1．除USB连线接头外，禁止其他任何接头的带电拔插。 
2．原则上运行完一个程序后，要进行下一个实验程序前，都需要退出 CCS 并复位

ICETEK-DM642-B 板，再重新进入 CCS 系统。 
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第六章 基于 ICETEK-DM642-B 的图像、语音和网络算法实现 

 

视频驱动程序应用 
 
一．实验目的 

1．了解视频编码的相关基本知识。 
2．了解 ICETEK-DM642-B 板上视频接口的连接和运行原理。 
3．了解设备驱动程序的结构及其使用方法。 
4．学习视频处理程序的编写、修改方法。 
 

二．实验原理 
1．视频编码 

(1) 数字图象：经过数字化转换并可以用数字表示、处理的图象。由象素点组成，其中横

向的点数称为水平分辨率，纵向的为垂直分辨率，一幅完整的图分为若干行，称为一帧图象。

每个象素根据量化精度不同其取值也不同，例如取三个色彩分量均为 8 位二进制数的 RGB
表示方法，用连续的三个 8 位二进制数表示一个彩色点，(200,100,64)描述的点的红色分量为

200，绿色分量 100，蓝色分量 64，其中每个分量的取值均为 0—255 表示从最暗到最亮 256
个等级。许多静态的图象可以经连续播放产生动态效果，25 帧/秒或 30 帧/秒的帧速可产生较

平滑的动态显示效果。 
(2) 色彩空间 

- RGB 色彩空间：图象采集和显示设备采用，例如 CCD、CMOS 摄像头，CRT 监视器等。

因其色彩分量之间有较大的相关性，不适于做图象处理。 
- YCbCr 色彩空间：Y 表示亮度，Cb 和 Cr 表示色差。各色彩分量之间相关性小，适于

进行处理操作。色差信号常做 2:1 抽样处理以节省带宽。 
(3) 视频图象 

视频简单地说就是活动图像。电影也是活动图像，电影把大量静止图像记录在胶片上，

一张一张地连续显示出来，就成了我们看到的电影。对于电视视频，每秒钟包含几十帧静

止图像，每一帧静止图像由几百个行组成，每一行又由几百个像素点组成。1 秒钟包含的

图像帧数为帧频，1 秒钟包含的总行数为行频，1 秒钟包含的总像素数实际上就是相当于视

频带宽。 
模拟视频：遥想起来，在当年有限的条件下，用电子管做出电视机的前辈们实在是令

人佩服的，但是，用现在的眼光来看，当年的电视技术又实在是很简陋的。我国的黑白视

频信号帧频为 25 Hz，就是说每秒显示 25 幅图像，之所以规定为 25 Hz，而不是其它的某

个值，主要是因为两个原因。一个与人的视觉生理特点有关，当图像的刷新速度达到 5帧/

秒的时候，人开始感觉图像是活动的，而达到 24 帧/秒的时候，人感觉图像是完全连续和
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流畅的（电影所使用的帧频就是 24 Hz），所以视频信号帧频应大于等于 24 Hz。理论上来

说帧频越高越好，但是帧频越高，对电路的要求也越高，技术越复杂，成本也越高（现在

有的电脑彩显帧频已达到 200Hz），在当时的条件下，只能选择一个大于 24 的尽量小的值。

另一个原因是因为我国的电网频率是 50Hz，当采用 25 Hz 帧频时，隔行扫描时的场频为 50 

Hz，正好与电网同频，这样，电源对图像的干扰是固定的，人眼不容易感觉出来，或者换

个角度说：电源就可以不必做得那么精密（那个时候开关电源还很少使用，整流电源缺乏

稳压措施，纹波很大）。所以选择了 25 Hz 帧频。说到这里，又要说说“场频”。电视在显

示图像的时候，把一帧分成了两场来显示，一个场由帧中的奇数行组成，叫做奇场，另一

个场由帧中的偶数行组成，叫做偶场。之所以要这样做，主要是因为在 CRT 显象管上一秒

钟显示 25 帧图像时，人眼感觉到连续性还是不太好，而且还有明显的闪烁，一帧分成两场

后，场频为 50 Hz，图像更加连续一些。当然还有一些别的原因，与电路设计方面有关。 

我国的黑白视频信号规定每帧图像共 625 行，每场为 312.5 行，行频 15625 Hz，视频

带宽 6MHz。在每场的 312.5 行中，有一些行要用作场消隐，是不包含视频信号的，按照

CCIR656 标准规定的行编号方法，奇场的行号为第 1 至 312.5 行，偶场的行号为第 312.5

至 625 行，其中，奇场的第 23.5 至 310 行包含有效的视频信号，共 287.5 行，偶场的第

336 至 622.5 行包含有效的视频信号，共 287.5 行。所以一帧中有效的总行数为 576 行，

由最上面的半行加上中间的 574 行加上最下面的半行组成。 

彩色视频信号：当科学家们开始研究彩色电视的时候，黑白电视已经大量使用了，所

以最好彩色电视信号能够与黑白电视信号保持兼容，以便彩色电视信号在黑白电视机上能

播放出黑白的图像。这个问题是很困难的，因为色度信号也要占用较大的带宽，而在电视

射频频带上，一个频道挨着一个频道，亮度信号（实际上还有调频的伴音信号）已经把频

带给塞满了，幸运的是，后来终于运用压缩亮度信号带宽、大面积着色等 

 

技术解决了这个问题。从频域的角度来看，色度信号（UV 色差信号）是插在亮度信号的频

谱的间隙之中的，具体的位置是插在 4.43MHz 的地方，带宽 1.3MHz。在接收机中，简单地

说，把收到的信号中的 4.43MHz 处的带宽 1.3MHz 的信号取出来就成了色度信号，而把收到

的信号中的 4.43MHz 处的这个信号滤掉剩下的就是亮度信号。很多硬件工程师可能不容易
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理解这是什么意思，不过没关系。下面我们从时域的角度来看看它们的一行的波形，如图

所示，黑白视频的亮度信号采用了调幅制，一行的周期是 64μs，其中显示在屏幕上的信

号占 52μs，其余部分为行消隐、行同步头。对于彩色信号，还在行同步头上叠加了一小

段 4.43MHz 的副载波信号，用作接收机中的 4.43MHz 信号的频率和相位基准。 

上面说的是彩色视频信号怎么加到原来的黑白视频信号中。那么彩色图像是怎么还原

和显示出来的呢？我们知道，黑白图像的像素只能用亮度（灰度）来描述。而彩色图像的

像素的描述要复杂一些，有很多不同的方法，比如在印刷行业中用的是 CMYK（青、品红、

黄、黑）四色合成的方法，而在计算机或电视机的 CRT 显象管中都是用的 RGB（红、绿、

蓝）三基色合成的方法，我也不明白为什么要选这三种颜色，而没选别的颜色，我猜想可

能是因为人眼包含 RGB 三种色感细胞，所以用这三种基色能合成比较多的人眼能识别的彩

色出来，或者因为这三种基色的荧光粉比较容易制造。通过 RGB 三基色来合成某种彩色，

或者某种彩色怎样分解为三基色，这个是大家都熟悉的。用 RGB 三基色来表示彩色的确很

直观，但是如果把这种方法用作图像传输则绝不是一个好的方法。第一个缺点是与黑白图

像不兼容，把 RGB 三基色转换为灰度的方法是：灰度=R*0.3+G*0.59+B*0.11,这个转换过程

显然是比较复杂的。对于电视机而言，就意味着必须解码出 RGB 信号才有可能得到黑白图

像，而黑白电视机没有解码功能，所以不能实现兼容。第二个缺点是占用太多带宽，用 RGB

三基色表示图像，每个分量的带宽是均等的，都约等于亮度信号的带宽，所以对于每个分

量，都要用较大的带宽来描述。第三个缺点是抗干扰能力差。由于 G 分量占有亮度值的 59%，

所以当 G 受到干扰的时候，像素的亮度值会受到很大的影响，而人眼对亮度值的变化是十

分敏感的，所以图像主观质量会明显下降。基于这些原因，在视频信号传输中采用的是 YUV

合成的方法。Y 代表亮度信息，U(Cb)代表蓝色色差（就是蓝色信号与亮度信号之间的差值），

V(Cr)代表红色色差。我们来看看使用这种表示方法的优点。第一个优点是与黑白图像兼容。

假定一个像素是用 YUV 表示的，我们只要忽略 UV 分量，取出 Y分量，就可以得到像素的亮

度值，从而把彩色图像转换为黑白图像。这样很容易实现彩色电视信号与黑白电视信号的

兼容。第二个优点是节省带宽。说这个问题的时候要先说说大面积着色原理。实验发现，

人眼对亮度信息是敏感的，主要通过亮度差别来分辨物体形状的细节，而对彩色信息是不

敏感的，人眼区分不出物体颜色上的细小的变化，或者说人眼不容易觉察出来图像的色彩

的细节部分的变化。因此，可以对亮度信号用较高的采样频率采样，而对色度信号用较低

的采样频率采样（或者用较低的量化深度），比如几个相邻的像素的亮度值不同，但是却可

以使用一个相同的色度值。这就是大面积着色原理。基于这个原理，在电视信号传输中，U

或 V 信号的带宽远小于 Y 信号的带宽，这样就节约了带宽。换个方式来说，比如在计算机

中，用 RGB 方式描述一个像素需要 R、G、B 共 3 个字节。而用 YUV 方式描述，则对于每 2

个像素，Y用 2 个字节，U 取相同的值，用一个字节，V 取相同的值，用一个字节，平均每

个像素 2 个字节。或者每个像素 Y 用一个字节，U 用半个字节，V 用半个字节，共 2 个字节。

第三个优点是抗干扰能力强。由于亮度信号是单独表示的，所以如果色差信号受到干扰，

不会影响到亮度，主观感觉噪声不会明显增加。 

在电视机中，彩色视频信号首先分解为亮度信号 Y 和色度信号，色度信号再分解为 U

色差信号和 V 色差信号，最后由 YUV 三个分量经过矩阵运算变换为 RGB 信号，以便在显像
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管上显示。 

视频信号的缺点：1.帧频低。视频信号的帧频只有 25Hz，必然导致图像闪烁。2.分辨

率低。在一帧中有效的行只有 576 行。由于采用了隔行扫描，一帧图像要由连续的两场来

拼合而成，而实际上很难保证两场中的行准确地错开（对准间隙），这进一步导致垂直方向

的分辨能力损失。3.亮色串扰。亮度信号和色度信号混合在一起，解码的时候不能很好地

分开，导致亮度信号和色度信号互相干扰。4.缺乏改进余地。除非重新制定新的标准，否

则前面提到的三个问题在现有基础上都很难改进。视频信号格式有这么多缺点，是因为受

当年制定这个标准时的技术条件制约造成的，而近年来通过在电视中加入一些数字处理的

手段，比如倍频扫描（100 Hz 场频）、使用数字梳状滤波器等方法，电视的图像质量也得

到一些提高。而现在正在研究的数字电视，是重新制定的全新的标准，用以获得胶片质量

的图像，可能会彻底淘汰现在的视频标准和电视设备。 

数字视频：视频信号起初是以模拟信号的形式保存在录像磁带上的，而现在随着数字

技术的发展，可以变成数字信号保存在光盘或计算机硬盘中，当然这些离不开功能强大的

计算机，实际上，在嵌入式领域，数字视频也是可以应用的，比如用单片机或 DSP 来处理

数字视频数据。 

模拟视频信号解码并量化成连续的数字视频流后所包含的一些信号元素：模拟视频信

号每秒 25 帧，每帧周期 40ms，而每帧又分为 2 场，每场 20ms，先输出的是奇场，然后是

偶场，奇场的行号为第 1 至 312.5 行，偶场的行号为第 312.5 至 625 行，其中，奇场的第

23.5 至 310 行包含有效的视频信号，偶场的第 336 至 622.5 行包含有效的视频信号。把模

拟视频信号解码为 YUV 分量后，分别进行 A/D 量化采样，转换为数字视频流，时间上也应

该是按上面的顺序依次输出。有几个相关的国际标准对此作了一些约定。比如 1994 年国际

无线电咨询委员会出台了 CCIR601 标准，这个标准主要是针对演播室的要求制定的，其中

规定亮度信号的采样频率是 13.5 MHz，色度信号的采样频率是 6.75 MHz，采用 8 位 PCM

编码。这样，每行的 Y 采样数为 864 个，其中有效的 Y 采样数为 720 个。而每行的 U 或 V

采样数为 432 个，有效的 U 或 V 采样数为 360 个。平均描述每个像素的 YUV 的位数分别为

8bit、4bit、4bit，又叫做 YUV422 编码方案（当然还有很多别的方案，如 YUV411 等）。国

际无线电咨询委员会还出台了 CCIR656 建议，其中规定视频数据的量化值中的 0 和 255 保

留不用，而量化数据串行输出的顺序是：U0、Y0、V0、Y1，U2，Y2，V2，Y3，U4，Y5，V4，

Y6，如此循环。通过上面的讨论，我们可以看出，数字视频流应包含的元素有：奇偶场指

示信号 FI（有的称为 ODD）、场同步信号、行同步信号、像素时钟、YUV 数据输出。在此我

们顺便计算一下数字视频流的数据量，每秒的数据量=（720 像素*576 行*25 帧）*2 字节

=20736000 字节，数据率约 165Mbps。 

(4) 图象传输格式(H.26x) 
- SQCIF：Sub-QCIF，128x96 
- QCIF：Quarter-CIF(1/4 x CIF Resolution)，176x144 
- CIF：Common Intermediate Format，352x288 
- 4CIF：4 x CIF Resolution，704x576 
- 16CIF：16 x CIF Resolution，1408x1152 
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2．ICETEK-DM642-B 板上的视频接口 
(1)视频输入：视频信号为标准 PAL 制电视模拟信号。信号经过视频解码芯片(AD 转换芯

片)TVP5150(U11)解码成数字并行信号 BT656 码流送 DM642 的视频接口。 
(2)视频存储：DM642 的视频接口解码 BT656 码流，得到图象，自动通过 EDMA 传输到

SDRAM 中存储。 
(3)图象处理：DM642 的 CPU 通过访问 SDRAM 中的图象，进行处理后送输出缓冲区

(SDRAM 中)。 
(4)视频输出：DM642 的视频接口(输出)自动通过 EDMA 从 SDRAM 中的输出缓冲区取得

数据后形成 BT656 码流送出。 
(5)TV 输出：视频编码芯片(DA 转换芯片)SAA7121 接收输出 BT656 码流，转换成标准电

视信号输出到输出插座 J6。 
 
 
3．视频驱动程序 

(1)DDK：DSP/BIOS Driver Developer’s Kit，提供 C 语言接口的 DSP 片上或扩展的外围设

备的驱动，它是 CSL 的补充，DDK 使用 CSL 提供的接口初始化和操作这些外设。例如它

提供音频编码解码(Codecs)、PCI 控制器、视频接口(Video Ports)的驱动程序。 
(2) 设备驱动程序在应用程序中的位置： 

 

 
(3) 在程序中使用设备驱动程序 

- 在 DSP/BIOS 设置程序中添加用户定义设备(Device Drivers -> User Defined Devices)。 
- 在 DSP/BIOS 设置程序中添加或在程序运行时添加 PIO/DIO/GIO 的驱动实例。 
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- 在程序中通过设备驱动程序初始化设备。 
- 在程序中使用设备驱动程序功能调用实现对外设的操作。 

(4) VPort 接口的设备驱动程序 

 

 
三．实验步骤 

1．实验准备 
(1) 连接设备 
①关闭计算机和评估板电源。 
②连接 ICETEK-5100USBV2.0A 仿真器一端的黑色插头到 ICETEK-DM642-B 板上 J1 插

座(JTAG)。 
③连接+5V 电源线到 ICETEK-DM642-B 板上 J2 插座。 
④连接视频输入到 ICETEK-DM642-B 板的 J4 接口。 
⑤连接视频输出到 ICETEK-DM642-B 板的 J6 接口。 

(2) 开启设备 
①打开计算机电源。 
②打开 ICETEK-DM642-B 板+5V 供电电源开关，注意 ICETEK-DM642-B 板上指示灯

DS2 亮，表示供电正常。 
③附带的 USB 电缆连接计算机(最好使用 PC 机机箱后部的 USB 插座)和仿真器相应接

口，注意仿真器上两个指示灯均亮。 
④双击运行桌面上“初始化 ICETEK-5100USB 仿真器”，在弹出的 DOS 窗口中观察初始

化操作结果。 
如果窗口中最后一行显示“This utility has successfully reset the controller.”，并提示

“按任意键继续…”，表示成功地初始化仿真器，可按键盘上空格键继续下步操作。 
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如果窗口中没有出现“按任意键继续…”，请关闭窗口，关闭实验箱电源，再将 USB
电缆从仿真器上拔出，返回第②步重试。 

如果窗口中出现“The adapter returned an error.”，并提示“按任意键继续…”，表示

初始化失败，请关闭窗口重试两三次，如果仍然不能初始化则关闭实验箱电源，再将 USB
电缆从仿真器上拔出，返回第②步重试。 

(3) 设置 Code Composer Studio 为 Emulator 方式 
(4) 启动 Code Composer Studio 

双击桌面上“CCS 2(‘C6000)”图标，启动 Code Composer Studio。成功后可看到 CCS
环境界面。 

  
2．此项实验需要连接 PAL 制式电视摄像头作为视频输入，有显示 PAL 制式电视信号能力的

电视显示器作为视频输出设备： 
(1)打开工程：菜单“Project”->“Open”，选择 C:\ICETEK-DM642-B\VideoLoopback 目录

中的“video.pjt”。 
(2) 浏览工程中源程序并理解含义 

①打开 video.cdb 文件，展开“Input/Output”->“Device Drivers”->“User Defined Device”。 
②观察其中的三个驱动程序：“VP0CAPTURE”、“VP1CAPTURE”和“VP2DISPLAY”,
方法是用鼠标右键单击相应设备名并选择“Properties”。 
<分析>添加设备驱动程序的方法： 

- 用鼠标右键单击“User Defined Device”，选择“Insert UDEV”，设备列表中新增加

“UDEV0”设备。 
- 用鼠标右键单击“UDEV0”设备名并选择“Rename”修改其名称。 
- 用鼠标右键单击修改后的设备名，选择“Properties”，设置其中各项。需要查阅

c:\ti\ddk\docs\vport.pdf 中“2.1 Configuration”，按照其中说明设置。 
③展开“Scheduling”->“TSK – Task Manager”，发现其中多了一个任务“tskLoopback”，
程序中将开启“tskLoopback”指定的任务用来处理设备驱动程序提供的视频数据流。 
④用鼠标右键单击“tskLoopback”并选择“Properties”，发现其中“General”属性页中

“Automatically allocate stack”项被选中，意即任务需要自动建立私有的栈，并在下面分

别指定其尺寸为 1024 字和位置为 SDRAM。打开“Function”属性页，在“Task function”
项中指定了任务函数的函数名为“_tskVideoLoopback”，在 C 语言程序中有名为

“tskVideoLoopback()”的函数作为此任务的处理函数。 
<分析>添加任务的方法： 

- 用鼠标右键单击“TSK – Task Manager”，选择“Insert TSK”，将新增加的任务名修

改成自己定义的名称。 
- 用鼠标右键单击任务名并选择“Properties”，在“General”属性页中设置堆栈参数。 
- 在“General”属性页中设置任务优先级：由于程序中任务不多，优先级设置得可以

仅比背景任务高 1 级，背景任务优先级为 0，则设置“Priority”项为 1。 
- 在“Function”属性页中设置任务函数的函数名，如果是 C 语言函数需要在函数名
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前加底线。 
⑤ 展 开 工 程 目 录 中 “ video.pjt ” -> “ Source ”， 发 现 其 中 有 文 件

“evmdm642_vcapparamsPAL_EMBEDDED.c”，观察此文件内容，其中定义了一些常数

数组和初始化参数，通过此文件指定此工程使用的视频输入设备为 PAL 制式的电视复合

视频信号，其中指定图象每场分辨率为 720x288(一帧 720x576)。 
⑥ 展 开 工 程 目 录 中 “ video.pjt ” -> “ Source ”， 发 现 其 中 有 文 件

“evmdm642_vdisparamsPAL.c”，观察此文件内容，其中定义了一些常数数组和初始化

参数，通过此文件指定此工程使用的视频输出设备为 PAL 制式的电视复合视频信号，其

中指定图象每场分辨率为 720x288(一帧 720x576)。 
<分析>更改工程支持的输入或输出设备的方法： 

- 将工程中 evmdm642_vcapparamsXXX.c 文件换成其他设置文件可修改输入设备的制

式 。 如 ： 需 要 改 成 NTSC 制 式 的 输 入 则 可 选 用

evmdm642_vcapparamsNTSC_EMBEDDED.c。 
- 将工程中 evmdm642_vdisparamsXXX.c 文件换成其他设置文件可修改输出信号。如：

需要改成 NTSC 制式的输出则可选用 evmdm642_vdisparamsNTSC_EMBEDDED.c。 
- 这些设置文件在 C:\ICETEK-DM642-EDULab\Lab506-519-VideoDriver\settings 目录

下。 
⑦打开程序源文件“video_ntsc_pal.c”，观察其内容：程序仅有两个函数，一个是 main()
函数，用作初始化，而另一个为视频处理的任务函数 tskVideoLoopback()。任务函数的结

构比较简单，首先是任务的初始化部分，然后是任务循环。在初始化部分，建立显示和

摄入设备的实例句柄，以便以后使用，然后是初始化设备、启动设备。在进程循环中具

体处理视频数据并送显示缓存。 
(3) 编译和运行工程 
①单通道视频输入、显示功能选项。编译、连接、下载程序后运行，可以观察到电视屏

幕中显示的视频，这个显示来自摄象头，并且是实时的。程序不断将视频输入的数据转

存到视频输出缓冲区完成实时视频数据的采集和显示过程。 
②停止程序运行，选择“GEL”菜单中“Resets”->“Reset_BreakPts_and_EMIF”。 
③关闭工程。 
 

四．实验结果 
- 通过实验，我们可以看到视频数据在视频接口驱动程序的驱动下运行良好，我们还可以控

制输入视频的制式及分辨率和输出视频的制式。 
- 输入视频数据的存储管理 

输入视频数据由 DM642 的 VPort 口解码后通过 EDMA 存储到 SDRAM 中，这个过程

通过输入视频接口的设备驱动程序完成。 
在配置输入视频接口的设备驱动程序时，至少指定它要开设 3 个以上的视频缓冲区，

设备驱动程序管理这些缓冲区用于实时视频数据的采集。 
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       a             b             c              d              e 
图示的是显示存储区管理方式。在驱动程序开始运行阶段，三个缓冲区轮流存放更新

的视频，如 a 所示；图 b 所示的是应用程序的视频处理任务首先从驱动程序申请使用一个

缓冲区，驱动程序将存放着最新视频数据的缓冲区(b 图中的 1)交给处理程序使用，而使用

另外两个缓冲区存储更新的视频；当处理任务程序完成了使用，将向驱动程序发送“切换”

命令，以切换缓冲区，驱动程序在提交存储着最新视频的缓冲区(c 图中的 2，或 d 图中的

3)给处理程序的同时，将交还的缓冲区投入使用；图 e 显示的是处理程序连续申请了两块

缓冲区时的情况。 
- 输出视频数据的存储管理：下图所示为视频输出时 VPort 口输出驱动程序的操作： 

 
类似地，输出驱动程序也维护至少 3 个缓冲区，其操作如下图： 

 
- 任务处理过程：在初始化部分将视频口驱动程序准备好，并从视频口驱动程序申请一

个输入缓冲区和一个输出缓冲区；进入主循环后，首先通过 DMA 调用将输入缓冲区

中的数据读出、处理，再将数据存储到输出缓冲区中，然后向视频口驱动程序切换输

入和输出缓冲区。当切换的函数没有完成时，任务将停止运行(堵塞)，当切换成功后

任务恢复运行。 
 

五．问题与思考 
- 如果视频处理任务不能及时地在下一个新的视频准备好之前完成处理，将会发生什么样的

结果？显示将会怎样？ 
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Flash 烧写和程序自启动 

 
一．实验目的 

1．了解 ICETEK-DM642-B 板上 Flash 模块的连接方式和工作模式。 
2．了解使用 FlashBurn 工具烧写 Flash 的基本原理。 
3．学习使用 FlashBurn 烧写 ICETEK-DM642-B 板上 Flash 的操作步骤。 
4．掌握 ICETEK-DM642-B 板自启动的方法和过程。 
5．学会编制自己的烧写程序，应用于自己开发的系统板上 Flash 模块。 
6．学习编写可以自启动的应用程序。 

 
二．实验原理 

1．ICETEK-DM642-B 板上的 Flash 模块 
ICETEK-DM642-B 板上使用 S29GL032 芯片提供 32M 位的 Flash 空间，其访问地址空间

为 CE1 空间 90000000h-90400000h。在逻辑器件的控制下，可分为 8 页访问。Flash 按照 8 位

数据宽度与 DM642 连接，亦即 CPU 读写 Flash 是按照 8 位的方式进行。 
一般来说，使用不同型号的 Flash，在接口数据位宽相同的情况下，其读操作是相同的。

不同的是写入操作，不同的 Flash 需要不同的写入时序和操作顺序，这需要参看具体 Flash 的

芯片手册。 
ICETEK-DM642-B 板上的 Flash 主要用于自启动功能。Flash 所需的高位地址线有 DSP

的 GPIO 提供。 
 

2．ICETEK-DM642-B 板从 Flash 自启动过程 
在系统结束复位状态时，DM642 将 Flash 空间(CE1 空间，起始地址 90000000h)的前 1K

字节复制到片内 0 地址开始的存储单元中，并从 0 地址开始执行。 
由于用户程序的长度往往大于 1K 字节，所以位于 0 地址的程序经常是一个装载程序，

它用来完成将应用程序从 Flash 中读出放到 RAM 存储器中，我们称这个装载程序为

BootLoader。 
数据在 Flash 中经常如此安排：开始的 1K 字节存放 BootLoader，接着是一个装载表，它

指示了随后存放的程序或数据应加载到 RAM 存储器的哪个地址以及加载长度等，随后程序

或数据分成多个块顺序存储。如下图所示。 
BootLoader 程序被开始执行后，首先设置关键的 CPU 和外设寄存器(如 EMIF 寄存器等)，

然后读入装载表，并按照装载表装载程序和数据，最后转到被装载的应用程序入口执行。 
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3．Flash 烧写工具——FlashBurn 简介 

烧写 Flash 可以通过编写一个在 DSP 上运行的程序将指定的数据写入 Flash 器件。另外

也可以利用一个现成的工具 FlashBurn。 
FlashBurn 工具可以直观地进行 Flash 的烧写，烧写的数据事先被按照指定格式存放到文

件中。由于 FlashBurn 不是 CCS 系统默认部件，所以需要单独安装。 
FlashBurn 需要在启动 CCS 时使用，实际上，它通过控制一个运行在 CCS 中的烧写程序

FBTC642.out 实现具体操作，包括擦除、烧写、回读等。用户可以根据使用 Flash 的具体控制

方法修改 FBTC642.out 程序的内容，形成自己的烧写程序 
 
三．实验步骤 

1．实验准备 
(1) 连接设备 
①关闭计算机和评估板电源。 
②连接 ICETEK-5100USBV2.0A 仿真器一端的黑色插头到 ICETEK-DM642-B 板上 J1 插

座(JTAG)。 
③连接+5V 电源线到 ICETEK-DM642-B 板上 J2 插座。 
④连接视频输入到 ICETEK-DM642-B 板的 J4 接口。 
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⑤连接视频输出到 ICETEK-DM642-B 板的 J6 接口。 
(2) 开启设备 

①打开计算机电源。 
②打开 ICETEK-DM642-B 板+5V 供电电源开关，注意 ICETEK-DM642-B 板上指示灯

DS2 亮，表示供电正常。 
③附带的 USB 电缆连接计算机(最好使用 PC 机机箱后部的 USB 插座)和仿真器相应接

口，注意仿真器上两个指示灯均亮。 
④双击运行桌面上“初始化 ICETEK-5100USB 仿真器”，在弹出的 DOS 窗口中观察初始

化操作结果。 
如果窗口中最后一行显示“This utility has successfully reset the controller.”，并提示

“按任意键继续…”，表示成功地初始化仿真器，可按键盘上空格键继续下步操作。 
如果窗口中没有出现“按任意键继续…”，请关闭窗口，关闭实验箱电源，再将 USB

电缆从仿真器上拔出，返回第②步重试。 
如果窗口中出现“The adapter returned an error.”，并提示“按任意键继续…”，表示

初始化失败，请关闭窗口重试两三次，如果仍然不能初始化则关闭实验箱电源，再将 USB
电缆从仿真器上拔出，返回第②步重试。 

(3) 设置 Code Composer Studio 为 Emulator 方式 
(4) 启动 Code Composer Studio 

双击桌面上“CCS 2(‘C6000)”图标，启动 Code Composer Studio。成功后可看到 CCS
环境界面。 

   
2．改造 VideoLoopback 成自启动程序 

- 打开 C:\ICETEK-DM642-B\VideoLoopback，将整个目录复制在同一目录下，将目录更名

为 VideoLoopbackflash。 
- 打开工程 C:\ICETEK-DM642-B\VideoLoopbackflash\video.pjt。 
- 浏览工程：此工程为上一个实验，采集图像然后输出的程序。 
- 修改 BIOS 配置文件： 

. 打开“video.cdb”，展开“System”，鼠标右键单击“MEM – Memory Section Manager”，
选择“Insert MEM”。 

. 鼠标右键单击“MEM0”选择“Rename”，改名为“BOOT”。 

. 鼠标右键单击“BOOT”，选择“Properties”。在“comment:”项中输入注释“BootLoader 
area”；在“base:”项中输入起始地址 0；在“len:”项中输入区域长度 1024；“space”
项选择“code/data”，去掉“create a heap in memory”前的对勾，单击“确定”按钮。 

. 鼠标右键单击“ISRAM”，选择“Properties”，将起始地址改成 1024，将长度改成 0x3FC00，
单击“确定”按钮。其中 0x3FC00 等于原来长度 0x40000 减去 1024。 

- 复制 BootLoader 程序： 
利用“我的电脑”，将 C:\ICETEK-DM642-B\VideoLoopbackflash 目录中的“boot.asm”

复制到新建的目录中。添加此文件到 video.pjt。 
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- 编写自己的连接命令文件：选择菜单中“File”->“New”->“Source File”，在新窗口中

输入如下内容(注意第一行减号后面字母为小写的“L”)。 
-l video.cmd 
SECTIONS 
{ 

.boot_load > BOOT 
} 

选择菜单中“File”->“Save As…”，将文件保存为 video1.cmd。 
添加 video1.cmd 到 video.pjt，并从工程中删除 video.cmd。 

- 编译、连接工程，生成 ledprd.out 文件 
3．生成 hex 格式烧写文件 

- 复制文件：将 C:\ICETEK-DM642-B\VideoLoopbackflash 目录中的“fpga_loader_ahex.cmd”
复制到新建的目录中。同时复制 hex6x.exe 和 out2hex.bat。 

- 打开“fpga_loader_ahex.cmd”，修改第一行的.out 文件名为 video.out，仍在 debug 目录下；

修改“ROM”定义中最后的输出文件名为“video.hex”，保存文件。 
- 用“我的电脑”执行 C:\ ICETEK-DM642-B\VideoLoopbackflash 目录中的批处理文件

“out2hex.bat”，观察窗口中的显示，按空格键关闭窗口。该目录中生成“video.hex”文

件。 
- 关闭“video.pjt”。 

4．烧写 Flash 
- 选择菜单“Tools”->“FlashBurn”。 
- 在 “ FlashBurn ” 窗 口 中 选 择 菜 单 “ File ” -> “ Open… ”， 选 择 C:\ 

ICETEK-DM642-B\VideoLoopbackflash 目录中的“ICETEK-DM642-B.cdd”文件。-单击

“Target System”中“FBTC Program File:”项后面的“Browse…”按钮，选择 C:\ 
ICETEK-DM642-B\VideoLoopbackflash 目录中的“FBTC642.out”文件。这时 CCS 开始

下载此文件到 DSP 上，如果成功，“Target System”中显示“Connected”，否则请退出

FlashBurn 重新操作。 
- 选择菜单“Program”->“Erase Flash”，擦除原来内容。等待擦除完毕。 
-在“File To Burn:”项中选择烧写文件，请选择 C:\ ICETEK-DM642-B\VideoLoopbackflash
目录中的“video.hex”。 

- 选择菜单“Program”->“Program Flash”，进行烧写。等待烧写完成。 
- 退出 FlashBurn 和 CCS。 

5．测试自启动功能 
- 关闭 ICETEK-DM642-B 的电源。 
- 摘除仿真器上的 USB 电缆。 
- 打开 ICETEK-DM642-B 的电源。观察程序是否运行。 

 
四．实验结果 
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自启动程序运行正常。 
 
五．问题与思考 
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JPEG 网络摄像机 

 
一．实验目的 

1．学习使用 RF-5 设计框架构造应用程序。 
2．参考实例学习 JPEG 编码库的使用，可以对 D1 格式的视频图象进行实时压缩。 
3．参考实例学习 JPEG 解码库的使用，可以实时解码生成 D1 格式的视频图象。 
4．学习运用 IDMA 规范综合 JPEG 编码和解码库。 
5．了解使用 XDIAS 接口实现与算法库的协调工作。 
6．学习设计程序通过网络发送 JPEG 数据实现远程网络摄象机功能、点对点视频传输等实际

应用。 
 

二．实验原理 
1．数据流程 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
数据流程： 
(1)输入设备提供的一帧图象被采集到输入缓存，由 YUV 4:2:2 格式进行重抽样变为 YUV 
4:2:0 格式。 
(2)通过 SCOM 序列，图象被发送到处理任务模块。 
(3)JPEG 编码库程序产生用户定制压缩质量的 JPEG 图象。通过一个 SCOM 序列，生成的

图象被发送到网络任务模块。同时，JPEG 文件被发送到 JPEG 解码器，解码器产生一个

色差信号重采样 
YUV(4:2:2)->YUV(4:2:0)

摄入一帧 
图象数据 

视频源 

色差信号重采样 
YUV(4:2:0)->YUV(4:2:2)

显示此帧 
图象数据 显示设备 

JPEG 
编码器 

JPEG 
解码器 

SCOM 

SCOM 

输入任务模块 

输出任务模块 

处理任务模块 

SCOM 

建立 
网页 
文件 

网络任务模块 
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YUV 4:2:0 的图象。 
(4)通过 SCOM 序列将产生的 JPEG 图象发送到输出任务模块。 
(5)输出模块转换 YUV 4:2:0 格式的图象成 YUV 4:2:2 格式的图象并显示。 
 

2．程序流程 
(1)实验程序采用 RF-5(参考设计框架 5)来整合 JPEG 的编码、解码库。程序使用了 6 个任

务模块的结构。上图显示了 4 个任务模块。第 5 个任务是一个控制任务，它使用一个邮箱

发送消息给处理任务模块。处理任务模块从邮箱接收消息，并根据消息中指定的图象质量

调节图象帧率。第 6 个任务模块是网络初始化模块，它由 CDB 文件定义处理网络环境的

初始化。当网络准备好后，上图中的网络任务模块就被建立。 
在进入 DSP/BIOS 的调度程序之前，程序初始化了多个要使用的模块。包括： 
①处理器和系统板的初始化： 

-初始化 BIOS 环境和 CSL。 
-设置使用 128K 的二级高速缓存。 
-设置二级高速缓存可映射到 EMIF 的 CE0 和 CE1 空间。 
-设置 DMA 优先级序列长度取最大值。 
-设置二级高速缓存的请求优先级最高。 
-DMA 管理器用内部的和扩展堆初始化。 

②RF-5 模块的初始化： 
-系统初始化 RF-5 的通道模块。 
-系统初始化 RF-5 框架中用于内部单元通讯和传递消息的 ICC 和 SCOM 模块。 
-各通道建立在内部的和扩展的堆上 

③建立摄入和显示通道 
-建立和启动一个摄入通道的实例。 
-建立和启动一个显示通道的实例。 

 (2)在完成初始化工作之后，系统进入 DSP/BIOS 调度程序管理下的 6 个任务系统。6 个任

务通过 RF-5 的 SCOM 模块互相发送消息。以下是这 6 个任务： 
①输入任务 
输入任务从输入设备驱动程序获得视频图象。它使用驱动程序提供的 FVID_exchange

调用从输入设备获得一帧最新视频图象。获得的图象是 YUV 4:2:2 格式的，它被重采样

成 YUV 4:2:0。输入任务接着发送 SCOM 消息到处理任务，消息中包含图象数据指针。

接着等待发送的消息返回以继续处理。 
②处理任务 

处理任务包含两个单元。第一个单元是一个 JPEG 编码单元，它接受 YUV 4:2:0 格

式的图象，产生用户定制压缩质量的 JPEG 图象。处理任务模块发送附带 JPEG 文件的

SCOM 消息给网络任务模块。同时，第二个单元是一个 JPEG 解码单元，它接收 JPEG
压缩图象并生成解压缩图象。解码的图象格式是 YUV 4:2:0 的。在解码完成后，处理任

务等待发送给网络任务模块的 SCOM 消息返回。然后发送消息给输出任务模块，通知新
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的输出文件已经就绪。 
③输出任务 

输出任务将图象显示在显示设备上。它使用输出驱动程序提供的 FVID_exchange 调

用实现图象的显示。它得到的图象的格式是 YUV 4:2:0 的，需要重新采样成 YUV 4:2:2
格式。然后等待处理任务发来的消息以继续运行。 
④控制任务 

控制任务管理可选参数，可以控制 JPEG 图象帧率和压缩质量。控制任务检测参数

的改变，这些参数定义在一个全局结构“External Control”，同时将更新的参数复制到任

务自定义的结构“External Control_prev”中，并向处理任务模块的邮箱中发送消息。处

理任务模块定时检测这些消息并调用相应单元的控制函数。 
⑤网络初始化任务 
网络初始化任务启动网络环境。当网络准备好后，建立网络任务。 

⑥网络任务 
网络任务用于支持系统中的网络功能调用。当它初始化完成后，开始进入等待处理任

务模块发送的 SCOM 消息的状态。 
此例中，网络模块取得处理模块发送来的 JPEG 图象，建立一个存在 RAM 上的图

象文件 IMAGE1.JPG，这个图象可以由 HTTP 服务器识别并发送给 HTTP 客户端。接着

回发一个 SCOM 消息给处理模块，通知它已经准备好处理下一个 JPEG 文件。 
 
三．实验步骤 

1．实验准备 
(1) 连接设备 
①关闭计算机和评估板电源。 
②连接 ICETEK-5100USBV2.0A 仿真器一端的黑色插头到 ICETEK-DM642-B 板上 J1 插

座(JTAG)。 
③连接+5V 电源线到 ICETEK-DM642-B 板上 J2 插座。 
④连接视频输入到 ICETEK-DM642-B 板的 J4 接口。 
⑤连接视频输出到 ICETEK-DM642-B 板的 J6 接口。 

(2) 开启设备 
①打开计算机电源。 
②打开 ICETEK-DM642-B 板+5V 供电电源开关，注意 ICETEK-DM642-B 板上指示灯

DS2 亮，表示供电正常。 
③附带的 USB 电缆连接计算机(最好使用 PC 机机箱后部的 USB 插座)和仿真器相应接

口，注意仿真器上两个指示灯均亮。 
④双击运行桌面上“初始化 ICETEK-5100USB 仿真器”，在弹出的 DOS 窗口中观察初始

化操作结果。 
如果窗口中最后一行显示“This utility has successfully reset the controller.”，并提示

“按任意键继续…”，表示成功地初始化仿真器，可按键盘上空格键继续下步操作。 
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如果窗口中没有出现“按任意键继续…”，请关闭窗口，关闭实验箱电源，再将 USB
电缆从仿真器上拔出，返回第②步重试。 

如果窗口中出现“The adapter returned an error.”，并提示“按任意键继续…”，表示

初始化失败，请关闭窗口重试两三次，如果仍然不能初始化则关闭实验箱电源，再将 USB
电缆从仿真器上拔出，返回第②步重试。 

(3) 设置 Code Composer Studio 为 Emulator 方式 
(4) 启动 Code Composer Studio 

双击桌面上“CCS 2(‘C6000)”图标，启动 Code Composer Studio。成功后可看到 CCS
环境界面。 

  2．打开工程：工程目录 C:\ICETEK-DM642-EDULab\JPEGNetware 
3．浏览工程中源程序并理解含义。 
4．编译、连接、下载并运行程序，观察显示结果。 
5．观察 CCS 中“sdout”窗口中的显示，读取其中的“Network Added:”项中的 IP 地址，例

如：192.168.1.77。 
6．观察 CCS 中“sdout”窗口中的显示，确认最后显示：“Link Status: 100Mb/s Full Duplex”，
表示网络连接被正常初始化。 
7．打开浏览器，在地址栏输入上边得到的 IP 地址，观察网页。修改网页中的“压缩质量”，

观察结果。 
8．结束运行，退出工程。 
 

四．实验结果 
实验中通过网线将网络接收端和发送端直接相连，实现点对点传输视频网页，也可以采用

将 ICETEK-DM642-B 连接到局域网集线器、其他计算机通过局域网访问 ICETEK-DM642-B 板

网页方式。 
 

五．问题与思考 



        REALTIME—DSP系列应用丛书 

 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                      http://www.realtimedsp.com.cn 
电话：010-62105690（中继）/ 91-94                                      传真：010-62105699     

42

语音处理-数字回声 

 
一．实验目的 

1．了解 ICETEK-DM642-B 板上扩展语音编码解码芯片 AIC23 的方法和连接、控制方式。 
2．学习运用 TI 提供的 codec 驱动程序来实现语音数据的处理。 

 
二．实验原理 

1．软件结构 
本实验展示一个语音采集-回放任务，用 48K/秒的采样率采集立体声音频输入，用给定的

回声控制参数叠加数字回声后播放出来。 
 
(1)数据流图 
 
 
 
 
 
 
 
 
 
 
 
 
(2)程序组成：程序由单个任务组成(tskAudioDemo())实现下面功能。 

-建立音频数据输入输出流。 
-准备好音频数据输入输出流。 
-初始化数字回声处理缓冲区：这个缓冲区将保存大约最近 1 秒的音频数据。 
-进入无限循环：读取音频数据，处理数据，输出数据。 

(3)每个音频数据帧读写包含相当于 10 毫秒的立体声语音采样数据，每通道 16 位/采样值。

对于每帧音频数据，函数 copyWithEcho()完成下述功能： 
-计算数字回声样本缓冲区中的指针。 
-输入缓冲区中： 

.读输入样本数据，叠加削弱的回声样本。 

.限制计算结果在 16 位范围内。 

.写结果到输出缓冲区。 

.复制原始采样值到回声缓冲区。 

立体声

音源 

音频输出

插座 

 
语音采样 

延时 

 
合成和限幅 

回放语音数

据 
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-卷绕使用数字回声处理缓冲区。 
 

三．实验步骤 
1．实验准备 

(1) 连接设备 
①关闭计算机和评估板电源。 
②连接 ICETEK-5100USBV2.0A 仿真器一端的黑色插头到 ICETEK-DM642-B 板上 J1 插

座(JTAG)。 
③连接+5V 电源线到 ICETEK-DM642-B 板上 J2 插座。 
④连接视频输入到 ICETEK-DM642-B 板的 J4 接口。 
⑤连接视频输出到 ICETEK-DM642-B 板的 J6 接口。 

(2) 开启设备 
①打开计算机电源。 
②打开 ICETEK-DM642-B 板+5V 供电电源开关，注意 ICETEK-DM642-B 板上指示灯

DS2 亮，表示供电正常。 
③附带的 USB 电缆连接计算机(最好使用 PC 机机箱后部的 USB 插座)和仿真器相应接

口，注意仿真器上两个指示灯均亮。 
④双击运行桌面上“初始化 ICETEK-5100USB 仿真器”，在弹出的 DOS 窗口中观察初始

化操作结果。 
如果窗口中最后一行显示“This utility has successfully reset the controller.”，并提示

“按任意键继续…”，表示成功地初始化仿真器，可按键盘上空格键继续下步操作。 
如果窗口中没有出现“按任意键继续…”，请关闭窗口，关闭实验箱电源，再将 USB

电缆从仿真器上拔出，返回第②步重试。 
如果窗口中出现“The adapter returned an error.”，并提示“按任意键继续…”，表示

初始化失败，请关闭窗口重试两三次，如果仍然不能初始化则关闭实验箱电源，再将 USB
电缆从仿真器上拔出，返回第②步重试。 

(3) 设置 Code Composer Studio 为 Emulator 方式 
(4) 启动 Code Composer Studio 

双击桌面上“CCS 2(‘C6000)”图标，启动 Code Composer Studio。成功后可看到 CCS
环境界面。 

2．打开工程：工程目录 C:\ICETEK-DM642-B\Echo。 
3．浏览工程中源程序并理解含义。 
4．启动计算机上音频播放器，反复播放音乐。 
5．编译、连接、下载并运行程序，听耳机中的输出结果。 
6．结束运行，退出工程。 
 

四．实验结果 
有时会听到声音中混有较大的噪声，这是由于 JTAG 通信口的频率串扰导致的。可以采用独



        REALTIME—DSP系列应用丛书 

 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                      http://www.realtimedsp.com.cn 
电话：010-62105690（中继）/ 91-94                                      传真：010-62105699     

44

立的语音源，即不使用与仿真器同一台计算机发出的声音。或者在运行程序程序时选择“Debug”
->“Run Free”即可。 

 
五．问题与思考 

 


